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The big news this month is, of course, the release of Ubuntu 7.10 - Gutsy
Gibbon. I have done a fresh install of the Release Candidate of Gutsy and as I
write this the last of the major updates are complete and it is now final. Since I

run Kubuntu the one big disappointment is that Compiz Fusion is not enabled by
default nor does it have a simple tick box to activate said desktop effects. I am now
officially waiting until KDE4 for my fancy window decoration.

By the time you read this we will be announcing who will be producing the official
Full Circle Podcast. I am looking forward to this as I firmly believe the Ubuntu world
needs a podcast which will be informative, light hearted and family friendly. As soon as
we have a release date for episode one it will be announced on our web site and also in
Full Circle.

Brian DeLacey has written an excellent article about Gutsy over on the O'Reilly
ONLamp.com site - http://url.fullcirclemagazine.org/f35910 - which mentions this very
publication. Have a read over the article and don't forget to give it a "digg." The article
discusses what's new in 7.10 and has some excellent photo's.

Our stock pile of articles is gradually dwindling so we are looking for informative
articles for future issues of Full Circle. Remember: our audience is mainly beginner to
intermediate Ubuntu users so you don't have to be a rocket scientist to write for Full
Circle. For article ideas and information have a read through our Ubuntu wiki page at
https://wiki.ubuntu.com/UbuntuMagazine.
All the best,
Ronnie
Editor, Full Circle Magazine
ronnie@fullcirclemagazine.org

EEDDIITTOORRIIAALL

This magazine
was created

using :

mailto:ronnie@fullcirclemagazine.org
http://url.fullcirclemagazine.org/f35910
https://wiki.ubuntu.com/UbuntuMagazine
http://www.scribus.net
http://www.gimp.org
http://www.openoffice.org
http://creativecommons.org/
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NNEEWWSS Feel free to email news stories
to: news@fullcirclemagazine.org
Please include a source URL.

UBUNTU SERVER MANAGER
Ubuntu Server Manager is a web based GUI which allows the user to easily - and
graphically - set up an Ubuntu server. It is also designed to run on previous versions of
ubuntu. Some of the features planned for Ubuntu Server Manager are:
*Profiles export and import your
server setup, set up your server
export the settings and import to
create an identical server.

*Plugin based system , allows the
server to be enhanced with extra
features.

*Ease of use, the interface is being
designed to allow easy
administration and setup.

*One-click installation of new
services.

*GUI can optionally be used all the
time or just for inital setup.

This project is still in development
and is looking for volunteer testers
and server experts. Also python,
bash, xhtml, css and javascript
skills. Translators are also required.
If you would like to help out with this project, please contact oly@digitaloctave.com or
regiester with the Ubuntu Server Manager project at Launchpad :
https://launchpad.net/usm or join the IRC channel #ubuntusm on irc. freenode.net

The primary
mission of
Radio
Amarok is to
promote
Amarok and
the
propagation
of free music.
Therefore our mandate is to play as
much free music as possible 24 hours
a day, 7 days a week. Further goals are
to provide live informational "talk
shows" to enlighten users of recent
developments with Amarok and indeed
the KDE project as a whole.
Our target audience is Amarok users,
KDE users, and future/prospective
users of both projects. We aim to have
a minimum of two live "talk shows" per
week. Emphasis will vary between
"tech talks" with developers, or end-
user information sessions with Amarok
or KDE publicists.
Last but not least, our goal is to
achieve all this using Free Software,
utilizing projects such as Icecast/Ices
and IDJC. We hope that our use of this
software will increase awareness of
these projects and further their
development.
If you have anything to offer: sponsors,
artists, DJs, web developers and
designers, and at some point we’ll be
looking for a sysadmin. Contact via IRC
(irc.freenode.net #amarok.radio) or
email: mez@radioamarok.com

mailto:news@fullcirclemagazine.org
mailto:oly@digitaloctave.com
https://launchpad.net/usm
http://www.radioamarok.com
mailto:mez@radioamarok.com
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BBC Quietly Announces iPlayer
for Mac and Linux
After many complaints from Mac and
Linux users it seems that the BBC will
release it's iPlayer for Mac and Linux.

"The BBC has also confirmed that users
of Apple Mac and Linux machines will be
able to use its TV catch-up service from
the end of the year.

The broadcaster has signed a deal with
Adobe to provide Flash video for the
whole of the BBC's video services,
including a streaming version of its
iPlayer.

Currently only Windows XP users can
use iPlayer, downloading programmes
on to their PC and keeping them for up
to 30 days. "

Source:
http://url.fullcirclemagazine.org/34632b

Supplying UK With Ubuntu PCs
A few people on the Ubuntu-UK mailing list
have noticed that UK retailler Tesco's have
begun supplying PCs with Ubuntu pre-
installed on them.
While they may not be top of the range PCs
they are priced affordably (without
monitors) at £190 for the eSys AMD 3600
and £140 for the eSys Intel Celeron.
Intel PC:
http://url.fullcirclemagazine.org/0042dc
AMD PC:
http://url.fullcirclemagazine.org/8d3da2

Nokia excites with GPS, Wi‐Fi
internet tablet

Nokia has
introduced
a new
pocket-
sized
internet
and GPS
tablet
that's

designed to complement rather than
replace your mobile.
The N810 connects to 82.11b/g Wi-Fi if
it's available or it can connect to the
web via your mobile using Bluetooth (a
bit like the doomed Palm Foleo). Nokia
has signed deals with Wi-Fi hotspot
providers including the UK's The Cloud
for access.
In addition to a 4.13-inch 800 x 480
resolution wide display, the model also
boasts a fold-out full Qwerty keyboard.
There's an integrated GPS receiver as
well, which allows you to pinpoint your
position and find a wide variety of
points-of-interests using the pre-loaded
maps.
Naturally, the Linux-based N810 is also
intended as a music player with 2GB of
internal memory plus an optional 10GB
memory card. And there's support for a
wide range of formats including iTunes'
AAC.
Source:
http://url.fullcirclemagazine.org/3fce9e

Driver Update Can Cause
Vista Deactivation
"...I've finally had it confirmed
by Microsoft Australia and USA
— something as small as
swapping the video card or updating a
device driver can trigger a total Vista
deactivation. Put simply, your copy of
Windows will stop working with very little
notice (three days) and your PC will go into
"reduced functionality" mode, where you
can't do anything but use the web browser
for half an hour."
Source:
http://apcmag.com/vista_activation

http://url.fullcirclemagazine.org/34632b
http://url.fullcirclemagazine.org/8d3da2
http://url.fullcirclemagazine.org/0042dc
http://url.fullcirclemagazine.org/3fce9e
http://apcmag.com/vista_activation
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FFLLAAVVOORR OOFF TTHHEE MMOONNTTHH
Written by Robert Clipsham

In this issue's Flavor of the Month we will show you how to upgrade your Ubuntu from Feisty Fawn (7.04) to Gutsy Gibbon
(7.10). Please be very careful, you do this at your own risk, we can not be held responsible for failed upgrades.

update

1Make sure you have
anything valuable
backed up! it is probable

that everything will run
smoothly, but just in case you
should back up anything
important.2Update and upgrade all your

packages. You can do this
via the Update Manager

(System > Administration >
Update Manager), or by running
sudo aptitude update && sudo

aptitude upgrade

in a terminal.3The Update Manager should
now say "New distribution
release '7.10' is available" (if

not you can run gksu "update-
manager -c" in a terminal or using
the run application dialog box -

alt+f2), with an Upgrade button next
to it. Click it to begin the upgrade
process. 4It is likely you will see a

message about
applications no longer

being supported by Canonical.
You can safely ignore this, just
click Close.

5When the 'Distribution
Upgrade' has finished its
preparations it will confirm

that you want to start the
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upgrade. Make sure you have
saved and closed all open
applications/documents at this
point before you click "Start
Upgrade." I would also
recommend closing any
applications using third party
repositories eg. Compiz-Fusion
(you can close it via the system
monitor, System > Administration
> System Monitor). You can
enable it again after the upgrade.
Once you are sure you have
closed anything that could
interfere with the upgrade
process, click "Start Upgrade."

6It will begin to download the
new packages for the
upgrade, then once it is

complete it will start installing the
packages. At some point during

the upgrade it will probably remind
you of those packages it mentioned
earlier. You can choose to remove
the packages or leave them there. I'd
recommend removing them to make
sure the upgrade goes as smooth as
possible, so unless there is an
absolute need to keep them, click
Remove.

7When it has finished
installing the packages the
computer will request to

be restarted. Wave goodbye to
the Feisty Fawn, then click
Restart Now.

8Once restarted you will be
left with your new up-to-
date Ubuntu - 7.10.

These steps are subject to
change as this guide was written
with the Release Candidate of
Ubuntu 7.10. Should you have
any problems with upgrading,
you can get help in the
installation and upgrades section
of Ubuntu Forums -
http://ubuntuforums.org/forumdis
play.php?f=140.

http://ubuntuforums.org/forumdisplay.php?f=140


8

HHOOWW--TTOO
Written by Luca De Marini

Well we all know one of the biggest lacks of The Gimp is that is misses a good number of plugins. Photoshop is the one software
everyone loves and uses when they have to apply any sort of mutation/transformation to its images, or when they have to create
outstanding graphics with the help of well projected plugins. For Photoshop there are hundreds of plugins around. Is this a problem for
The Gimp? Not at all.

UUSSEE PPHHOOTTOOSSHHOOPP
PPLLUUGGIINNSS IINN GGIIMMPP

Many of you may not know
it, but GIMP supports a
large number of

photoshop plugins, both in the
Windows and Linux versions,
thanks to this wonderful tool
called PSPI. Now, let’s see how to
use it and what we can do with
our new toy; paying nothing, of
course!
Getting Started

First we need to install WINE on
our Linux box (In Ubuntu, look for
the WINE package in Synaptic),
then we’ll need GIMP and PSPI, of
course. We also need at least one
Photoshop plugin. To get started
and I downloaded two plugins,
one commercial and one
freeware. The first one is Designer
Sextet from the company Flaming

Pear and for the second plugin, the
freeware one, I’ve chosen
Caravaggio from Xero Graphics.
Installing PSPI and
Photoshop plugins

Now it is time to install PSPI on
your GIMP. The following is an extract
from the PSPI site:
'The Linux packages include three

files: README. linux pspi, a small
shell script pspi. exe. so, the binary
that wine runs'

Copy pspi and pspi.exe.so to your
personal GIMP plug-ins folder,
typically ~/.gimp-2.2/plug-ins .

When you run GIMP it will issue a
warning “wire_read(): error” as
pspi. exe. so can’t be started directly.
(The pspi script can, though, and is

from GIMP’s point of view a GIMP
plug-in.) This warning is
harmless (GIMP just ignores that
file then), but if you want to
avoid it, move pspi.exe.so
somewhere else and modify the
pspi script to point to its new
location instead.

After starting GIMP, go to the
Xtns:Photoshop Plug-in Settings
and enter the folder where you
are going to keep the 3rd-party
Photoshop plug-ins (.8bf files)
that you want to use in GIMP.

Preferably you should use an
empty folder for this, and then
install (copy) Photoshop plug-ins
there one by one, verifying that
each works. It isn’t really useful
to rush and install a great deal of
Photoshop plug-ins at once and

https://www.gimp.org


9

assume they all will work under
pspi.

So I did what they wrote in the
instructions and also copied my
freshly downloaded PS Plugins to
a folder in my home that I called
~/.gimp-2.2/psplugins.

Remember that this GIMP folder
we are referring to is a hidden
folder, therefore, you’ll have to
set your file browser so that it
shows hidden files. In my case, I
use GNOME and Nautilus. I can
see hidden files by using the
Nautilus menu View > Show
hidden files.
Setting The GIMP UP

As the guide says, I start GIMP
and it hangs up for some seconds

analyzing the newly installed plugin:
But once

GIMP is
loaded I get
no error
message as
expected
(The PSPI
guide
suggested

that an error may have occurred but I
didn’t see any). All works fine for
now. Proceeding with the settings, I
open the GIMP Menu Xtns >
Photoshop Plug-in Settings and this
window shows up:

Hit the New button (In my
screenshot it is the white sheet of
paper with an orange star over it, on
the upper left corner of the above
screenshot) and choose the path
where you put your Photoshop

plugins. In my case we saw that
it is /home/darkmaster/.gimp-
2.2/psplugins.

Push the OK button and a
message will appear warning
you that the new plugins will be
loaded next time you restart The
GIMP.
Testing the new PS Plugins

To complete the operation I
close and then reopen The GIMP.
Even now I don’t get any error
message. I then load an image
from my HDD and then click on
the Filters menu. The plugins are
at the bottom of the menu.
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Let’s test them! Will they work?
I start with Flaming Pear >
Aetherize and… wow it works!
Here’s a screenshot!

Now it’s Caravaggio’s turn and
wow, it works too! Another
screenshot for the press:

This is the result of applying the
Caravaggio filter (right)

Now doesn’t that look like a real
painting? This Caravaggio plugin
is excellent and it’s freeware.

Conclusions

So I tested two random Photoshop
plugins from around the net and two
of two worked. Guess there’s a very
high compatibility thanks to Wine
getting better and better with each
release.. What can I say now? Enjoy,
and say goodbye to one of the most
deprecated defects of GIMP, the lack
of good and professional plugins! If
you have the money, you can buy
and use serious plugins like those
from Alien Skin in Linux with The
GIMP and PSPI now!

Rating and Credits

Ok, it's not a review but none
the less I rate this PSPI extension
for GIMP as a 5 out of 5, it does
what it promises to do and it
adds vital functionalities to The
GIMP.

A big thank you goes to the
WINE project, PSPI team and to
GIMP creators.

For more PSPI info:
http://url.fullcirclemagazine.org/1fa7e2

http://url.fullcirclemagazine.org/1fa7e2
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HHOOWW--TTOO SSAAMMBBAA SSEETTUUPPWritten by Clinton Messer

This how-to assumes the following: You use the same login name on your Windows and Linux computers. You are using Static IP's
behind your router. You can use a text editor (Nano, Kate, emacs, vi, gedit, or whichever text editor you like).

Basically, you need to do the
following:

* Install Samba packages
* Create your smb password for
your account
* Create/Modify the smbusers file
* Modify the smb.conf file to enter
the information for your users and
the shared drives they will access.
* Start the Samba Server

The process is really simple; it's
just somewhat tedious.

First off, install your samba
packages using Adept, Synaptic or
apt-get. Kubuntu 6.10 comes with
the package “samba-common”
installed by default, but SAMBA is
neither fully installed nor set up,
so you need to grab the packages.

Installing the packages

samba
samba-doc

(samba-doc means you can learn
the finer points of tuning a SAMBA
setup)

These additional packages may or
may not be needed, but I installed
them anyway:
komba2
smb4k
swat
Create/Set the smb password

Then, you need to set your user's
smb password to be the same
between windows and linux by

performing the following
command at the command line
(Terminal window)
sudo smbpasswd -a bob

Then, enter your password.
In the example above, bob is

the person logged in and
entering the command on the
machine called bob-samba.

By running the command
above, bob will get prompted to
create a password for a user
named bob. This username
should be the same login name
you use to access your Windows
and Linux boxes.
Create/Modify the

smbusers file

Once you've set the smb
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password, you need to either
modify or create the smbusers file
sudo nano /etc/samba/smbusers

Then, enter your password.
In the smbusers file, modify/add

the following line:
USERNAME = "network username"

USERNAME = the name you are
going to use to log into the
machine with. Using bob as an
example, it would look like:
bob = "network username"

Save the file in your text editor
and exit the editor.

Modify the smb.configuration file
sudo nano /etc/samba/smb.conf

Then, enter your password.
You can use whatever editor. I

use nano since it's present in both
Kubuntu and Ubuntu.

In the smb.conf file, make the
following additions:

Locate the section titled
[global]

If the following entries do not exist,
add them. If they do exist and are set
to something else, modify them to
read:
workgroup = MSHOME

Enter your workgroup's name here
in place of MSHOME.
netbios name = bob-samba

Enter the HostName here of your
*buntu box.

Scroll down to locate the following
entry:
; security = user

Remove the semi-colon ( ; ) from
the entry above and add the
following line directly below it
username map =

/etc/samba/smbusers

Scroll down to the section
==== Share Definitions ===

in that section, locate the
entry labeled
[printers]

After the last entry for printers,
enter the information for your
shares.

I place my shared drive entries
after the printer section because
it works for me but you can put
them anywhere in the Share
Definitions section

I named each of my shares in
the smb.conf file to match the
name of the drive as it appears
in the /media/ folder. I
recommend using this method
for the sake of simplicity.

You can copy and paste the
following entries if you want. Just
be sure to modify them to reflect
your drive names and user
names
# My Shared Folders

[DRIVE1]

path = /media/DRIVE1/

browseable = yes

read only = no
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guest ok = no

create mask = 0644

directory mask = 0755

force user = USERNAME

force group = USERNAME

[DRIVE2]

path = /media/DRIVE2/

browseable = yes

read only = no

guest ok = no

create mask = 0644

directory mask = 0755

force user = USERNAME

force group = USERNAME

In place of the "USERNAME" entries
above, make sure USERNAME is set
to the same username you use to log
into the system on both Windows
and Linux

The group name should be set to
the groupname your Linux login
name is set to.

Once all these steps are complete,
you can try starting up Samba and
accessing the shares.
sudo testparm

Then, enter your password.
Then restart Samba

sudo /etc/init.d/samba

restart

Then, enter your password.
You should now be able to

browse the network from your
windows machines and
see/access/read/write to your
shared Linux Drives.

UBUNTU 7.10 ‐ GUTSY GIBBON IS NOW AVAILABLE FOR DOWNLOAD

http://www.ubuntu.com/getubuntu
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This month we're going to discuss Templates. Templates are crucial to a good layout. Your Template
will lie behind your content and auto-generate page numbers. It is essential to plan your layout carefully because all your pages
need to work together to form a single magazine, not look like they've all come from different magazines.

HHOOWW--TTOO
Written by Ronnie Tucker

PART 6

First of all, let's add a page to
our current page. On the
main menu, click Page >

Insert
Here is

where you
can insert a
single, or
several,
pages and
insert them
before or
after a

certain page or just insert them at
the end. Here, I'm choosing to
insert two pages at the end. Don't
worry about the Master Pages bit,
we're going to create those
Master Pages soon enough. Size
and orientation usually never
need to be touched unless you're
creating a publication with
different sized pages.

So now we have three pages, but
wouldn't it be better if we had them
side by side like having a real
magazine lying open? Well, we can
but just remember that page one is
the cover and will always be by itself
but pages two and three will be side
by side.

In the main menu, click File >
Document Setup

This is where the settings for
the entire document are stored,
from the items down the left side
of the window you can fill in
author information, set guides,
default fonts and all that other
fun stuff. For now though, choose
Double Sided in the Document
Layout box and below that the
drop down menu should say that
First Page is : Right Side, this
means that page one will be on
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the right side so page two will be
a left page and page three will be
a right side page, in other words:
what most left to right readers will
be used to. Now click OK.

I've zoomed out in the above
screen but you can see that page
one is the cover, the magazine
sitting closed, and pages two and
three are side by side just like a
magazine being opened. Why?
Because your template can have
a left page and a right page so
you can make a nice layout that
could span across two pages.

But let's get to making template
pages. In the main menu, click
Edit > Master Pages.

The
extra little
window
that
popped up
is your list
of Master
Pages
(aka:

Templates). For now you only have
the one, called Normal, so we'll edit
that for now. Now this is important:
you are not editing any text or
images of content. You're only
editing things that are going to
decorate the page which are not
content, you'll see what I mean in a
moment. For now let's just add some
shapes, fade them and see what
happens.

So I've created some shapes and
made them transparent. So let's see

what happens when we return to
normal content editing mode. To
return to content editing simply
close the Edit Master Pages
window.

As expected, the Normal
Master Page applies to all page
in the publication so if you try
and move those shapes around,
you'll see you can't, they're
locked in place and only editable
in the Master Pages section of
Scribus. Nifty!

Let's create left and right
Master Pages to show you how
to apply them. Again, we click
Edit > Master Pages, now in the
Master Pages window click the
top left button, looks like a single
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sheet of paper, this will create a
new Master Page layout.

I'm calling mine My Left Page,
and in the drop down menu below
the name it says Left Page. Make
sure this matches what your
creating, otherwise the left page
you create will end up on the right
pages. If that happens just edit
that drop down menu to fix things.

So I've created a large shape for
my left page layout, for my right, I
just create another Master Page
but this time:

I make sure that my drop down
menu says Right Page.

Although the page has gone blank,
don't panic. If you click the My Left
Page you'll see that your left page is
indeed still there, safe and sound. So
I'll create my right page now.

And again close the Edit Master
Pages window to go back to content
editing mode.

To apply a Master Page to a
document page, simply right click on
the page and choose Apply Master
Page

Notice at the top of the
window is where we choose a
Master Page to apply, I'll apply
my left page here and if my
document had many pages then
I could choose to apply it to all

even
pages,
since my
left page
here is
page
two, an
even
page.
And click
OK.

Job done! Do the same for
page three and we're almost
there. Now remember: you can
be as elaborate as you like with
your layout. I've only used a
single simple shape per page but
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you can have faded images on
there, nice colorful boxes and
what not so be creative. Just
remember that your text will have
to go on top of this template so
make sure you won't have black
text on a dark piece of
background, there's nothing
worse!

One more thing your Master
Pages will need is guides.
Guidelines essentially. These can
change from Master Page to
Master Page but it's usually best
to choose one versatile guide set
up and stick with it. If you want to
do this it's best that you put your
guides on one Master Page then
duplicate the Master Page, by
clicking the little button that looks
like two sheets of paper, then add
your left and right designs. Here
I'll add some guides to my left
page. First we go back in to Edit >
Master Pages then right click on
the page and choose Manage
Guides.

Here we set up guidelines which
we can snap to which can help us
align text, images and other
things. I'll set up a three column

page, like we do with Full Circle.
In the

bottom
half of
the
window I
click to
have
three
columns,
then I
tick

Column Gap and have a value of 30
in there. So I could use that for my
text, but I'd like a horizontal line
across the page, roughly a third of
the way down for my header stuff.
Easy done, we just click Add where it
says Horizontal Guides, give it a
value of 200 and we're almost done.

One
last thing
to do
though is
to tick
the box
on the
right to
Lock
Guides
and, if

need be, Apply To All Pages. I'm
done, so I click OK.

But where are my guides? Well
sometimes they are turned off.
Simply go to the main menu and
click View > Show Guides. If you
want your items to snap, or jump
and align to, your guides then
click Page > Snap To Guides.

Now, lastly, the all important
page numbers. This is easy. Go
in to Edit Master Pages again
and click on which page you'd
like to have a number. I'll put
one on my left page. Click the
Insert Text Frame button – just as
though you were putting content
on a page – and again as we did
before, double click the text box
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to add text but, rather than type
in text, go to the main menu and
click Insert > Character > Page
Number and you'll see a hash
symbol (#) appear in your text
box. That's fine.

TIP: If you intend to have ten or
more pages then make sure you
do that insert piece twice to get
two hash (#) symbols.

Don't forget to format the page
number too, give it color and size.
Now close the Edit Master Pages
window. Scroll down and there
you have it, one page number.
Wherever that Master Page is

used it will auto-generate the page
number. Put one on your right page
and you'll see.

Be creative with your Master Pages
but also be aware that when people
view a PDF they can usually over ride
your double page setting and view
the document page by page so don't
rely on a double page layout to make
your magazine look flashy, a lot of
times the user will view page by
page, certainly on slower machines.

Next month we'll move on to
linking where you can link
internally, where a user could
click on an item in the contents
page of your document and jump
to that page, or external links,
where the person could click on
a link and be taken to a web
page.

FULL CIRCLE
MAGAZINE
NEEDS ARTICLES!

Guidelines

The single rule for an article is; it must
somehow be linked to Ubuntu or one of
the many derivatives of Ubuntu
(Kubuntu, Xubuntu, Edubuntu etc).
Please follow these rules :
* Write your article in whichever

software you choose, I would
recommend OpenOffice, but most
importantly - PLEASE SPELL AND
GRAMMAR CHECK IT!

* In your article, please indicate where
you would like a particular image to be
placed. Please do NOT embed images
in your ODT (Open Office) file.
* Images should be either JPG or PNG.

If you must use JPG please use very
little compression.
* Regarding image sizes; if in doubt,

send a full size screengrab and we will
crop the image before publication.
* For a more detailed list of the style

rules and common pitfalls please refer
to: /Style
When you are ready to submit your
article please email it to:
articles@fullcirclemagazine.org

https://wiki.ubuntu.com/UbuntuMagazine/Style
mailto:articles@fullcirclemagazine.org
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IINNTTEERRVVIIEEWW
Written by Shirish Aharwal

The Open Font Library is a sister project of the Open Clip Art Library. The goal of this project is to collect public domain fonts
so that they may be used freely.

JJOOHHNN PPHHIILLIIPPSS
OOPPEENN FFOONNTT LLIIBBRRAARRYY

What inspired you to start
the Open Font Library (OFL)?

My previous work on Inkscape
and Open Clip Art Library
(openclipart.org) and a desire to
help build out communities where
none exist. I'm interested in
bridging the various free and
open graphics communities and
the fonts-domain is a super weak
area. The thinking is that by
focusing a community of
designers around fonts, the
quality of fonts around the
desktop will increase similar to
how Inkscape has helped improve
overall design of the free desktop.
What advantages does the

OFL have over other sites
offering free fonts?

It is focused on what the free
and open software/content

communities desire, so the entire
operation is transparent and open.
There is the SIL Open Font License
and CC Public Domain declaration in
place to help free fonts for use, re-
use and remix. Also, the software is
completely free software and using
Creative Commons' open source
project, ccHost
(http://creativecommons.org/projects/
cchost)
What do you hope to achieve

through OFL?

We hope to improve the overall
quality of fonts on the free and open
desktop. We want to have
completely brilliant, free and super
high quality fonts for anyone to use
on the free desktop. If that happens
to solve needs for the larger world,
then so be it! But, we have found
focusing on a specific area is vital to

a project like this.
What goals do you have

for the OFL?

I want to make this a super-
dynamic community that lowers
the barrier for participation in
creating fonts, which is a hard
endeavor to do! I'm particularly
interested in developing a
friendly culture that makes
lovely international fonts and
also as being a place for free and
open fonts to be pushed
upstream. If one looks at the font
packages in various distros, it's
totally a mess! Also, there are
some fonts where the licensing
and/or agreement for usage is
dubious.
Can Windows or Mac users

use OFL fonts?

http://creativecommons.org/projects/cchost
http://openfontlibrary.org/
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Yes, there shouldn't be any
problems. We are focusing on
collecting both the source and
output of font files. George from
Fontforge is an active community
member and has worked to make
this a nice reality. We have the
good folks in the larger free and
open font community helping to
make sure the site is useful.
Is OFL the first site you've

worked on?

Hopefully it doesn't look that
way! No, I've been working in the
field for like 14+ years now. I've
been building websites and
projects for ages. I started in free
and open source with Inkscape
and have worked at various
companies doing open site design
and project building. Inkscape
work transitioned into Open Clip
Art Library
(http://openclipart.org), which
always is in need of other
developers! I also have built large
projects for my present employer,
Creative Commons.
How did you create the site?

(software, language, etc)

I used to be anti-website engine in
favor of pure html, php, and css. But,
have converted to building most of
my projects with Wordpress. When I
first started working for Creative
Commons, I was tasked with building
up the engine behind the big music
remix community, ccMixter
(http://ccmixter.org). The engine that
powers that site is called ccHost
(http://creativecommons.org/projects/
cchost) and there was a decision
made at some point that this engine
is the best way forward for building
Open Clip Art Library and Open Font
Library. It is totally great to develop
on this engine and is underscored
that Creative Commons has a full
time developer hacking on it in
addition to other community
contributors, of which I am one now,
since I have transitioned to being the
Business + Community Manager for
Creative Commons.

Anyway, in terms of tools I use:
vim, ssh, evolution (for lots of
coordination), pidgin (for lots of chat)
and epiphany web browser for wiki
editing and testing.

Note, that this project is a large
collaborative project, so it's not just

me. I try to structure out a road
map for our community of
contributors, and then we all
(ideally) lend a hand.
How long did it take you to

create the first version of the
OFL site?

Half-day at best, because I'm
an expert at installing ccHost. It
still looks quite similar to Open
Clip Art Library, but that is just
because we wanted to get the
core functionality solid before
fixing the site's decorations ;)
If somebody made free

fonts which license should
they put them under?

That is a tricky question and I
recommend anyone [who's
interested] to talk to a lawyer
about [it]. There are some
problems at least in the USA with
how fonts work with copyright.
With the project we have taken
the approach of both allowing for
no license (public domain) and
the SIL Open Font License
because that license has been
sussed out by SIL for free-ness

http://openclipart.org
http://ccmixter.org
http://creativecommons.org/projects/cchost
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and potential legality issues. So, I
can't really recommend what
license to use, but you can use
Open Font Library as a great place
for free and open fonts.

I would say however that source
code licenses are not tailored for
content, such as GPL and LGPL.
The SIL Open Font License is
tailored for fonts.
How much time and how

many steps are there in
making a font?

Sadly enough, I don't directly
make fonts. I'm the community-
building guy on the project and
rely heavily on Dave Crossland,
George Williams and others to
handle this aspect of the project.
They are great to talk to about
building fonts. In the times I've
worked on fonts, back when I did
design, it is a time intensive task!
Any specific suggestions for

the free software community
so font designers feel more at
home here?

Yes, jump into helping out at
http://openfontlibrary.org The

project is an open book, so its open
to you to change it!
Do you use free software to

make free fonts or do you feel
the need for using commercial
software to achieve the same?

I've used both [types of] apps.
George's FontForge is a great tool
that now has the ability to save fonts
directly to the Open Font Library,
which is quite cool!
A brief list of software, what

are your comments on the ones
which are in use for free font
development:

FontForge - The number one app at
the time! Go George! It would be
great to get a GTK-based interface
for this and would open the door for
more developers, but that's been on
the table for a while.

Inkscape - Of course Inkscape is
the best vector editor in the world!

Gimp - Gimp is useful for
converting old typefaces, etc...
always brilliant.

scribus-font-preview - Awesome!

Any suggestions for
upstream free software font
tools to make font designers
feel more at home?

If you aren't on our list and
talking with us, please do so! We
want to make the healthiest font
ecosystem possible!
What advice would you

give to anyone thinking of
starting a similar site?

Make a solid plan and double
any estimates for how long you
think tasks will take. Also, it is
nice to have a plan for keeping
afloat financially.

John had plenty more to say on
the subject of Apple, RedHat
and the GPL. To read the entire
interview head over to our web
site :
http://www.fullcirclemagazine.org

http://openfontlibrary.org
http://www.fullcirclemagazine.org
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MMYY OOPPIINNIIOONN
Written by James Savage

WWIINNDDOOWW MMAANNAAGGEERRSS

We ran a poll in Ubuntu Forums asking: What window manager do you use? Although not many people voted there were some
surprising choices and comments.

mrmonday
Currently an
OpenBox-GNOME
user. I switch
between window
managers
though. I'd be
using Compiz
Fusion, but I've
got over the
graphical effects,
and it uses 50%+
of my CPU since
the last update -
no update since
and re-installing

didn't help. GNOME with OpenBox is
a great combination imo, mixing
beautiful low resource borders and a
simple to use panel
nathangrubb - Fluxbox

yabadabbadont - Fluxbox built
from SVN.
saxonjf - I use GNOME right now,
but if it's easy enough to use, I
may very well go to Compiz
Fusion.

pluviosity - I use a combination
of GNOME, KDE, and Compiz
Fusion, with KDE being my most
used window manager

Hardly a surprise, but it seems
that GNOME out ranks both KDE
and Compiz by almost 5 to 1.
Surprsingly, Beryl seemed less
used than Compiz and poor Xfce
gained only one vote. Fluxbox
seems to be the light-weight
window manager of choice these
days.

If you would like to post a poll for a
future issue of Full Circle, please post
your poll in our Ubuntu Forums > 3rd
Party Forums section:
http://url.fullcirclemagazine.org/c7bd6f

http://url.fullcirclemagazine.org/c7bd6f
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MMYY SSTTOORRYY FFEEEELLIINNGG SSEECCUURREEWritten by Mike B

I must admit, the first time I installed a Linux distribution I had that strange feeling of something missing. It took me a few
minutes to identify it since I had so many things to discover and understand with this new experience. Then, suddenly, a
shocking cold wave passed through my body. A firewall, an anti-virus …fast…fast. Desperate, panicked I’ve started a two fast
two furious search using Google, for a Linux firewall and an anti-virus.Google is good, but not when

you’re really sweating cold.

“Let’s be calm. There is no
hurry. No need to do damage by
using something you don’t know.”
Yeah, I was kind of right, but Linux
was such a thrill. I felt that I had
discovered something new, really
big, I was entering in a whole new
world.

I used Google, calmly this time,
and the first thing I noticed is that
there were a lot of people with
responses of the type: “an anti-
virus for Linux? Nah, I don’t use
one. A firewall for Linux? There's
already one built in”.

Since this experience with the
new OS to enjoy, I’ve used Linux

for days and days, without booting
into my Windows installation. But
still, even though I knew that I was
working in a possibly secure
environment, I still had that feeling
of something missing, and in some
cases, especially when reading all
that news about security and holes
and bugs and, and... I had a feeling
of insecurity too. The calm of the
KDE desktop... no Zone Alarm or
Kasperksy alerts, no daily anti-virus
updates, it was a stress I couldn't
handle. “The syndrome of the
desktop calm”, that’s what I called it.
Maybe I had invented a new mental
problem, whatever it was. I was
suffering from it. Even friends more
experienced than I was admitted to
experiencing it as well. Was there no
cure for it.

I was conscious that I was secure,

but that feeling was still there a
month later. I’d see myself
opening new search pages in the
middle of other tasks, searching
again and again on the same
arguments almost unconsciously.

Then one day I discovered two
packages that finally brought me
peace: Firestarter is just a
frontend for Iptables, the built in
firewall, which allows you to
apply some rules easier and
watch your traffic. It has also
some alerts, and a red flashing
light, my saviour. And then
Clamav so I could scan ports!
Even if there was no real-time
protection. What did these
packages offer me? Not much.
But seeing those small icons was
what my mind wanted. t was a
fake feeling, but it was my cure!
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UUBBUUNNTTUU YYOOUUTTHH
Written by Andrew

The future of Open Source is in the Young People of today; that's
why this corner of the magazine is for young people or simply
those who are young at heart.

I used to really be into the “Box
Theory.” When you need
something, there is a box at

your local computer store to cover
it. Inside the box was a CD, small
pamphlet telling you what you
can't do with the software on the
CD, and maybe a coupon or two.
Do you need a word processor?
$200 and up will get you one of
many colorful boxes at Best Buy.
Have some viruses? There are
boxes for that too. There were
boxes for everything.

This drove me mad, but I thought
it was the only way. In fact, I don't
think I had a single bit of Free/Open
Source software on my computer. It
was all proprietary software that
came from those boxes at Best Buy.

Now what about this: you get a
new computer with Windows Vista.
The next day, your teacher gives you
a writing assignment. You still have
yet to get Microsoft Word, and you
have never heard of FOSS (and let's
pretend for a moment that the
Windows build of OpenOffice doesn't
exist). There is no time to go to the
computer store, and this paper is
due tomorrow.

That's why I think that Ubuntu is
the perfect OS for teens. You need a
word processor? There's one
preinstalled. Virus protection? The
very fact that you're using Ubuntu is
virus protection! What if your
teacher wants some pictures with
that paper? No problem! Just go to
Add/Remove and find what you need.

Ubuntu is an excellent OS for
teens. It's easy to install things,
so whenever you need
something like a music
organizer, a word processor, or
even a game or two, you can
find it in Add/Remove Programs
on the Ubuntu menu. All those
royalties and license fees are a
thing of the past.

Not only that, but it's fun to
learn something new. I cannot
even begin to tell you all the
things I have learned in the past
year or so that I've been running
Ubuntu Linux.

Andrew is the
founder of
Teens on

Linux which
featured
recently in the

UK magazine Linux Formathttp://www.teensonlinux.org

http://www.teensonlinux.org
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LLEETTTTEERRSS Every month we like to publish some of the emails we receive. If you would like to
submit a letter for publication, even if it's a compliment or complaint, please email it
to: letters@fullcirclemagazine.org. PLEASE NOTE: some letters may be edited for spaceFirst off, the bad news: I think

you misplaced a screenshot
or two in the Top 5 category

this month. Unless I'm badly
mistaken, the screenshot shown
for "Glest" is actually a screenshot
from the wonderful game "Battle
For Wesnoth".

Thank you very much for the
excellent VirtualBox article. I had
tried recently to install VirtualBox
on Feisty, but I had had problems
with user groups. This article
clears up all my problems!
Stephen Nabholz

Ed: Yep, sorry about that, there
was indeed a bit of a mix up
between a couple of the Top5
screens. Glad to be of help with
the VirtualBox article. Quite a few
people have emailed us to say
that they enjoyed it. Big pat on
the back goes to writer Luca De
Marini who's written several good
articles for us.

I also have had a problem with
.mkv files and anything above
1280x1024. I've found that

mplayer is the software to use for
these files. It's the only package
that decodes the video files in a way
that's not resource intensive. Please
pass that info on to Walter for me.
Thanks!
Anthony Stellato

Ed: Several people wrote in
suggesting Mplayer as the best video
player for large MKV files, some also
suggested you install the restricted
video drivers Walter. Do let us know
how it goes.Iwas recently introduced to Full

Circle (Issue #5 is my first
experience), and my wife and I

are quite impressed. The entire
issue comes across as professional,
and the editing quality is very good.

We both enjoyed the article about
CoLoCo (kudos to those guys for
putting on what must have been an

absolutely stellar presentation!)
and we look forward to similar
types of articles. In addition to
that fabulous article, I think
many new users would be
particularly interested in the
concise "My Desktop" article. If
anything, this article should be
expanded to a minimum of two
pages. Having a spotlight on
software (such as the Top 5
Stragegy Games) is a wonderful
idea that can help new and even
veteran users become aware of
the best of the software
available. I wasn't aware of 4
out of 5 of those games you
listed!

So, thank you guys very much
for putting so much effort into
this publication. I look forward
to the next edition and I will be
downloading the first 4 issues
right away!
Mike Ireland

mailto:letters@fullcirclemagazine.org


26

I absolutely love Ubuntu Linux. I
love it so much that I really
want to contribute. But the

thing is, I can't program. Are there
any tips you could give me on
where to learn?
Tommy Alsemgeest

Ed: No comment! I'm throwing this

one out to the programmers! Guys,

what's the best language to learn for

helping out in the Ubuntu

community?

My question is about Linux
Certification and in
particular Ubuntu

Certification.
Could you explain a little more

about the Ubuntu Certification?
Where can I get the literature?
What are the "must have" study
books? Are there any online tools
to prepare for exams? Thanks a lot
Akall

Ed: As far as I'm aware the Ubuntu

Certification hasn't begun as yet but

I'm sure the good folks at Canonical

can answer this one?

For those who are not aware of
the details of this car, it was
debuted at the Mozilla 24

"Firefox Rock Festival" in Tokyo on
Sept. 15th. It will go on to compete in
the largest all-Japan custom car show
in Nagoya later in September.
Gen Kanai (Flickr.com user)MaximumPC magazines June

issue promoted going to
Linux and Ubuntu was the

distro focused on.
I setup a Dual Boot with Ubuntu /

XP and I could not be happier!
* Linux is Fast
* Everything is free
* All the information you could
possibly need is out there. I became

a forum member for the first
time.
* The graphics improved without
having to buy a new video card
(Windows would need one to do
the same thing!)
* I can keep this computer (AMD
2200 Sempron) for another 3
years easy with Linux!
* No viruses, etc.

I missed the command line
and batch files but after 2 weeks
of Scripts / Sudo / Anacron I have
control over everything. It's
more 'raw' but that's the fun part
- total control.

I am truly enjoying using my
computer again like I did during
the '90's. But instead of buying
hardware so frequently I can
enjoy the free Distro's!
William Covington

Ed: <memories> Ah the 90's, I
remember them well. My Atari
ST being sold off to get that
Amiga A500. My friend showing
off his flashy 486 PC with Doom
in a small window. Them were
the days! </memories>
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QQ&&AA
Written by Robert Clipsham

If you have an Ubuntu related question which needs answering, email it to us here
at questions@fullcirclemagazine.org, and we'll pass them to Robert for answering
in a future issue.

How can I get 'Ubuntu
User' and 'Linux
Registered User titles?

QI have seen that some
people have 'Ubuntu User'
or 'Linux Registered User' in

their signatures. How can I get
one?ASimply visit

http://counter.li.org to be
counted as a linux user, or

http://ubuntucounter.geekosophica
l.net for an Ubuntu User.
http://ubuntuforums.org/showthread.php
?t=290323QIs it possible to use a file

browser to view files over
ssh?AYes. Go to 'Places >
Connect to Server', select
'SSH' in the 'Service Type'

Menu. You can then enter your
details and choose your options.
You can use this method for other
types of connections too.
http://ubuntuforums.org/showthread.php
?t=558293

QHow can I get the trash icon
on my desktop?

ASimply press alt+f2, then
enter 'gconf-editor' in the box
that appears. Navigate to

/apps/nautilus/desktop, and check
the 'trash_icon_visible' box. You can
also add other icons in the same
section. Close the window when
you're done, and you will have the
trash icon on your desktop.
http://ubuntuforums.org/showthread.php?t=
390429

QI'm new to Ubuntu, and I'm
not ready to use it as my
default operating system yet.

How can I make Windows the default?

ATo do this you need to edit
your menu.lst. First back it
up in case you make a

mistake - cp /boot/grub/menu.lst
/boot/grub/menu.lst.backup.
Then you can edit it with 'gksudo
gedit /boot/grub/menu.lst'. You
need to change the 'default'
value to the number windows is
on the list. Each 'title' counts as
one. For more information see
http://www.gnu.org/software/grub
/manual/grub.html#default, or
the post mentioned below.
http://ubuntuforums.org/showthread.ph
p?t=574789

QHow can I upgrade to the
Gutsy Gibbon?

AHave a look on page 6
(this issue's Flavor of the
Month) for how to upgrade.

mailto:questions@fullcirclemagazine.org
http://counter.li.org
http://ubuntucounter.geekosophical.net
http://ubuntuforums.org/showthread.php?t=290323
http://ubuntuforums.org/showthread.php?t=558293
http://ubuntuforums.org/showthread.php?t=390429
http://ubuntuforums.org/showthread.php?t=574789
http://www.gnu.org/software/grub/manual/grub.html#default
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WWEEBBSSIITTEE OOFF TTHHEE MMOONNTTHH
Written by Daniel Cohen

The aim of this section is to find decent and relatively unknown websites that will help you with your daily Ubuntu needs (and general
curiosity). I will sum up the good and the bad points of the website, and -- with any luck -- the website owner will read the article and
then rectify any problems mentioned!

Ubuntu Tutorialshttp://ubuntu-tutorials.com/

This month's website is
somewhat different than the
previous websites. But that

isn't a bad thing. Ubuntu-tutorials
is a blog done by someone which
gives daily tips or how-tos.

So each day you get a new tip on
how to do something. Much of the
time it won't be needed by you, but
often you can find little tweaks that
can save time or just generally
improve your Ubuntu experience.

Blogs that use various tools online
to make them all have a familiar
layout, and this site is no exception.
To accompany the nice layout is a
good neutral theme which is easy on
the eyes and makes everything look
very clear.

Entries are organized on the left-
hand side in various categories
which allows you to find old posts
that are in categories relevant to
you. It also sorts them out into
monthly archives and has the latest
ten on that side as to make it easy
for you to find them instead of
having to scroll down for a long time.

The best part about this
website is that there is an RSS
feed. I won't go over what it is
but I will say that it is what
makes this website so good.
Even with all of the organized
categories and archives, it would
still be a pain to go there
everyday to check up that day's
how-to, only to are not
interested and have just wasted
your time. With the RSS feed it
conveniently allows you to have
it alongside all of your other
daily feeds (Slashdot, Sky, BBC
etc.), and so can see the
headline of the latest tip without
having to use your browser.

Even if you only get an
interesting article every few
weeks – because there is so little
effort needed to use these
resources, you may as well.

http://ubuntu-tutorials.com/
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MMYY DDEESSKKTTOOPPWritten by Martin Topping

MMYY DDEESSKKTTOOPP
Written by Steve Barcomb

This is your chance to show the world your fancy desktop or PC. Please email your screenshots and
photos to: misc@fullcirclemagazine.org and include a brief paragraph about your desktop, your
PC's specifications and any other interesting tidbits about your setup.

My box is nothing special at all - Pentium 4 1.7 GHz, 256 MB RAM, 20 GB
HDD - which is split evenly between Windows XP Pro and Feisty Fawn. I
wasn't sure if Feisty would run on this computer, I also had a Dapper CD

and nearly made do with that. But then I figured if it can't handle Feisty I can
always uninstall. So I fired up the box, fed it my Feisty Live CD, and clicked on
install, and I haven't looked back!

The video card is a NVidia TNT2, which is good enough for what I do. I watch
movie DVDs on my box, and play Alien Arena 2006, and it all looks okay. I don't
have the fancy desktop effects, but I found some nice graphics and I like the way
my desktop looks.

I thought I would share my brand new install of Ubuntu
7.10 and my simple customizations with the desktops
section. I suppose it's not much compared to others,

but it's easy on the eyes and works well for me.
Everything was done with Gutsy settings except for the

Ubuntu System Panel applet, the applet can be found by
searching USP Ubuntu on Google.

The panel and task bar auto hide but, I froze them for
this shot. The second shows the desktop when idle.
Background is a personal shot of Beaver Lake Nature
Center in CNY. Gutsy has been great.

mailto:misc@fullcirclemagazine.org
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TTOOPP55 RRAACCIINNGG GGAAMMEESS
Written by Andrew Min

TORCS

Homepage: http://torcs.sourceforge.net/If you want a powerful racing game, look no
further than TORCS, The Open Racing Car
Simulator. It's gone from a 1997 2D soapbox

derby simulator to a powerful 3D racing game with
championships, tons of tracks, a thriving
community, and all the third party tracks and cars
you can download. There are even two online
championships: TORCS Driving Championship and
The TORCS Racing Board.

To install TORCS, just use your favorite package
manager
(apt,
aptitude,
Synaptic,
Adept, etc)
to install
the 'torcs'
package
from the
universe
repository.

Your monthly Top5 list of obscure Linux games or
applications from the depths of the Internet. If you have an
idea for a list, please email: misc@fullcirclemagazine.org

VDrift

Homepage: http://vdrift.net/Want realistic racing? Then you need to try
VDrift. First released in 2005 by Joe Venzon
and inspired by Gran Turismo, Venzon

created a simple racing game powered by the Vamos
Automotive Simulator. Two years, three programmers,
and a ton of code later, it's got extremely realistic
physics, 28 cars, 19 tracks, AI players, networking,
and great looking graphics.

VDrift hasn't (yet) made it into the Ubuntu
repositories
(though the
data package
made it in.
Odd). Luckily,
GetDeb.net
includes an
Ubuntu
package for it.

mailto:misc@fullcirclemagazine.org
http://torcs.sourceforge.net/
http://vdrift.net/
http://www.GetDeb.net
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Trigger

Homepage:
http://sourceforge.net/projects/trigger
-rally/If arcade-style racing is your style,

give Trigger a try. It's simple: they
give you a car, and you have to

navigate a tricky path full of off-road
terrain with an extremely tippy car.
Go too fast, and you risk flipping off
of the road. But move too slowly, and
you risk being dominated by your
cunning AI opponents. Disclaimer:
Full Circle Magazine is not held liable
when your boss fires you for
spending five hours straight trying to
beat Trigger during that important
meeting with the client.
To install, just use your favorite package
manager to grab the 'trigger' package in
the universe repository.

SuperTuxKart

Homepage:
http://supertuxkart.sourceforge.net/If you're tired of realistic racing,

try SuperTuxKart. It was based on
Tux Kart, a game where users

race around a track and throw
power-ups at each other. For a
while, Tux Kart did well. But it
stagnated for several months. In
December, a Happypenguin user
named grumbel decided to fork a
version called SuperTuxKart. So in
2006, SuperTuxKart was released
with better AI, more characters,
more power-ups, more tracks, better
graphics, and tons of bug fixes.
By the time you read this, the latest
version should be available via the
package 'supertuxkart' in the universe
repositories.

Extreme Tux Racer

Homepage:
http://www.extremetuxracer.com/In 2001 the company

developing Tux Racer
announced they were going

commercial. Tux Racer never
saw another release after that
announcement. Luckily,
PlanetPenguinRacer had started
a fork. Although it was popular, it
too was abandoned by 2006. But
in March 2007 another group of
programmers decided to revive
the project renaming it to
Extreme Tux Racer because of
licensing issues.
To install, use the .deb provided by
Hamish or to follow the Building an
Ubuntu Package instructions at the
project wiki.

http://sourceforge.net/projects/trigger-rally/
http://supertuxkart.sourceforge.net/
http://www.extremetuxracer.com/
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We are always looking for new articles to include in full circle.
For article guidelines, ideas, and for issue translation, please see our
wiki: http://wiki.ubuntu.com/UbuntuMagazine
Please email your articles to: articles@fullcirclemagazine.org

Full Circle Team:
Editor
Ronnie Tucker
Webmaster
Rob Kerfia
Comms Manager
Robert Clipsham
Contributors
Samuel Barrett
Robert Clipsham
Daniel Cohen
Andrew Min
Proof Readers
Nicola Cappellini
Jonny Dover
Matthew Holder
David Maino
Richard Mills
James Savage
James Williams
Ryan
Our thanks go out to Canonical,
the Ubuntu Marketing Team and
the many translation teams.

If you would like to submit news, email it to:
news@fullcirclemagazine.org
Send your comments or Linux experiences to:
letters@fullcirclemagazine.org
Hardware/software reviews should be sent to:
reviews@fullcirclemagazine.org
Questions for future interviews should go to:
questions@fullcirclemagazine.org
Lists and desktop/PC photos should be
emailed to:
misc@fullcirclemagazine.org

If you have questions, you can visit our forum:
www.fullcirclemagazine.org

Deadline for Issue #7
Sunday 11 th November.

Projected release date for issue #7
Friday 30th November.

HAVE YOUR SAY
If you want to have your say in how
Full Circle develops, please attend our
monthly IRC meeting.
You can find our next Agenda at:
http://url.fullcirclemagazine.org/f2ba08
General meeting: Saturday 10th
November @ 1700 UTC - all welcome
Meetings take place in the IRC channel
#fullcirclemagazine, which is on the
irc.freenode.net server. Or you can
use our webIRC :
http://irc.fullcirclemagazine.org
which will allow you to interact with
the IRC channel from within yourweb browser.

http://wiki.ubuntu.com/UbuntuMagazine
mailto:articles@fullcirclemagazine.org
http://ubuntuforums.org/forumdisplay.php?f=270
mailto:news@fullcirclemagazine.org
mailto:letters@fullcirclemagazine.org
mailto:reviews@fullcirclemagazine.org
mailto:questions@fullcirclemagazine.org
mailto:misc@fullcirclemagazine.org
mailto:ronnie@fullcirclemagazine.org
mailto:admin@fullcirclemagazine.org
mailto:mrmonday@fullcirclemagazine.org
http://url.fullcirclemagazine.org/f2ba08
http://irc.fullcirclemagazine.org



